Installation Instructions - Configuring

IQ5, 1Q5-10
Controller & 1/0 Modules

Important: Retain these instructions

These instructions shall be used by trained service
personnel only. If the equipment is used in a manner not
specified by these instructions, the protection provided by the

equipment may be impaired. https://[partners.trendcontrols.com
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1 BEFORE STARTING CONFIGURATION

Install the 1Q5 and any required 1/O Modules Install IQ®SET on Engineering PC / Laptop

@ < §> @ - §> IQSET Manual (TE200147)

1Q5 Installation Instructions - Mounting (TG201482)
1Q5-10 Installation Instructions - Mounting (TG201484)
1Q4/10/.. Installation Instructions - Mounting (TG201342)

Additional Documentation Required
XCITE/IO/.. Installation Instructions - Mounting (TG200627) q

= IQSET Manual (TE200147)

Prepare the Ethernet Network(s) «  IP Tool Manual (TE200638)
= IQTool Monitor Applet Manual (TE201298)
Install DHCP Server = |QTool Addresser Applet Manual (TE201299)

If the IP address settings (IP address, subnet mask, default | = 1Q5 Configuration Manual (TE201486)

router, WINS and DNS servers’ addresses) are to be supplied

by a DHCP server, ensure one is installed on the Ethernet | Note: PDF copies are included with IQSET installation in the
segment to which 1Q5 is connected. following folder: C:\..\Trend Control Systems\Documentation

Install DNS Server

If email alarms are to be sent, and the email server address
is identified by internet domain name, a DNS server must be
installed.

Note: IQ5 does not support WINS. If hostnames are to be
used, then a DNS server is recommended. For security the
use of LLMNR protocol is not advised.

2 CONFIGURATION

Isolate All Power (including any I/0 supplies)
WARNING Connecting leads may be connected

to power supplies. Isolate before touching.

o o o o
. PSU . PSU . PSU PSU \
NN
S =
"°| 1Q5 [ 1Q5-10 || IQ5-10 | 1Q5-I0 | 1Q5-I10 1Q5-10 [ 1Q5-10
¥ — £ S
LTI T T
o o I o
\ PSU e \ PSU \ PSU
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1Q5, 1Q5-10 Installation Instructions - Configuring

2 CONFIGURATION (continued)

@ Open Panel / Enclosure

WARNING Opening the panel may expose
dangerous voltages.

’_\—

@ Peel Off Serial Label(s) and Retain (leave front panel protective film in place)

1Q5 1Q5-10 Modules

...

| —
@ Disconnect All I/O from 1/0 Modules
WARNING Connecting leads may be connected
to power supplies. Isolate before touching.
Leave 1Q5 Power, Ethernet,
RS-485, T1L 10 bus, 1Q3/4
10 bus and USB connected
(where appropriate). | | | |f| | | |f| | | |t| | | |t t t t
— J
|~ 105 | 1as-10 | 10510 | 1as-10 | 105-10 10510 | 1a5-10
¥ S = =
LTI SULMILL®
Remove terminal covers Unplug connectors Refit terminal covers
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Installation Instructions - Configuring

1Q5, 1Q5-10

2 CONFIGURATION (continued)

1 2 3
COM - + ™ +
RS485 n ISOLATED RS485 n ISOLATED
\ Terminator in circuit Terminator out of circuit

@ Configure XCITE/IO Modules (where fitted)

e

Section 2 Only

XCITE/IO/.. Installation Instructions - Configuring (TG200627)

Either: via Ethernet Hub/Switch

=

Standard Ethernet cable
(Cat 5e twisted pair)
max 100 m (109 yds)

Ethernet Network

VoL

Hub / Switch

@ Connect Engineering PC / Laptop (with IQSET installed)

Or: using direct connection

[t

Standard Ethernet cable
(Cat 5e twisted pair)
max 100 m (109 yds)

Note: A connection via the USB Local Engineering Port cannot
be used at this point.

1Q5, 1Q5-10 Controller & 1/0O Modules Installation Instructions - Configuring TG201483 Issue 1, 04-Oct-2023



1Q5, 1Q5-10 Installation Instructions - Configuring

2

CONFIGURATION (continued)

Switch On Power to 1Q5 (including any additional T1L 10 and 1Q3/4 Bus PSUs)

—_

PSU PSU

“‘“’I 1Q5 || 1Q5-10 || 1Q5-10 || 1Q5-I0 || 1Q5-10 1Q5-10 | 1Q5-10

@ Wait for Controller to Boot Up
—\ J

=L %90 oo 0.%

=30s =45s

Check 1Q5 Status Indicator
. Expected indications
_\ j_ Controller is running OK.

/ Proceed to step 11.
TREND | @ £ One or more modules on the T1L bus
C))( or 1Q3/4 10 bus is not yet addressed
_—— correctly. This can be ignored at this

_( L stage - proceed to step 11.

O

Fault indications

Displayed for longer than 60 seconds.
The controller boot up process has
encountered a problem. Try resetting the
1Q5 to default settings (see page 19).

No power - check input power supply

OO
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Installation Instructions - Configuring 1Q5, 1Q5-10

2 CONFIGURATION (continued)

@ Set Display Language on 1Q5-10 HOA Modules (if required)

On initial power up only:

..... (
A
e : Deutsch
H Francais
O v Espafiol
i Italiano
pa—
\\

Note: To change the language after initial setup, reset the
module by following the procedure in section 7 on page 20.

@ Check Status of T1L 10 Bus (only if IQ5-10 modules are connected)

1Q5
[t P . - . .
—\ }— Normal operation indication
o Bus is connected and working correctly.
() Bus is not connected (no T1L modules).
e | 5T
Fault indication
[ Bus is connected but not working correctly.
[ \_ Check the bus wiring and that all IO modules
© are powered ON.
1Q5-10 Modules

Normal operation indication

Bus is active on both sides of the module

Bus is active on | Valid for the last module on
left side only the bus.

Bus is active on

g ‘ For all others, check wiring
right side only

on the side that is unlit.

er|or|or
oOx|@exUw|o™

Fault indication

L R | Novalid T1L connection. Check the bus wiring.
@ @

|
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1Q5, 1Q5-10

Installation Instructions - Configuring

2 CONFIGURATION (continued)

Check Ethernet Indicators (for any connected ports)

Normal operation indication

1000 Mbps link detected

100 Mbps link detected

10 Mbps link detected

i

X

Note: The indicator will flash when data is being transmitted
or received.

Connect to 1Q5 using IP Tool

Using the PC/laptop (see step 7) run IQSET / IP Tool

IQSET Manual (TE200147)
IP Tool Manual (TE200638)

eabs

SET
File Project View | Tools | Window Help
D& ¢ @ SET Options ool @ ip=160.221.45.122 ub=255.255.255.0 (tr=160.221.45.1 chcp=10228.4010 wins=) o x
— end | Request Tend Device [~ FideEating ~ Defaut [ (| idelp | 1a3Address | Clar
ToolSET O = | Do Det Panel Settings | 52V© Fie| OPenFle) copumns. Wizard P | List
System View oolSET Options
[Wessage from 00-10.7050 5
Security Options a
~ — s A
A e enter Xg
e —
Lan: Os: e s virual VR AR ',;
IV Auto-p DACP " [Siatus || Fort | P Adar/lame e A
¥ tetworked Veavat 101 10101 = ce | 2
Context: r na 0o o Auto-Number §
w0 0 voncs 232
o TCLTool 2 v o o ‘/
oo
statsage [ wontter hostname [ type [ ver [ sooress Lcetaut router | wins. oo - | group
3 w2z TREND-70.0589 15 100 A AucpDi. L 160221453 2552552550 160221451 0000 102.. Y 57612
Then find the 1Q5 by oo G5 100 A Averon . L ozt es ezt 0000 02 B ez
. /e TRENDBETTS K0S 100 A AuopDH. L 180221454 10220451 0000 f02. Y 76tz
its MAC address, as s 100 A AuopOH. L 18022145141 25 160221451 srery
’ o 1 145234 TREND-DCDGE1 105 100 A Auto-pDH.. L 160221455 2552552550 160221451 0000 102.. XX s7612
shown on the p
serial label

1 O )

M
[]pfm]
[=]:.2

SN: 2345HSPI090T1234
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Installation Instructions - Configuring

2 CONFIGURATION (continued)

1Q5, 1Q5-10

Set up IP Addressing Details

With the 1Q5 selected in the IPTool devices list, check the following parameters and set as required.
IMPORTANT: The Network Key, lan and node parameters MUST be set.

" = operate in standalone mode

Parameter Setting / Value Further Details
Network Mode ¥ = build Trend network with other devices | In standalone mode the 1Q5 will not build a LAN or
- Networked* (default) internetwork with other devices.

Network Mode
- Auto-ip-DHCP*

¥ = dynamic IP DHCP (default)
" = static IP addressing

If set to DHCP mode but no DHCP server is found, the 1Q5
will operate in link/local mode where it auto negotiates its IP
address with other devices on its Ethernet segment.

Note: It is recommended that link/local only be used on a
single segment system.

IP Address*,
Subnet Mask*,
Default Router*

If static IP addressing is selected enter the
required values in the format:

XXX XXX XXX XXX

WINS is not supported by IQ5. If hostnames are to be used,
then a DNS server is recommended. The use of LLMNR
protocol is not advised.

Hostname

Default is ‘“Trend-’ plus the last three octets
from the MAC address. Change if required.

The hostname may comprise upper or lowercase characters
A to Z, digits 0 to 9, underscore or hyphen, with no spaces.

UDP

Default is 57612. If required, this can be
changed to a value from 49152 to 65535.

Network Key

Enter a suitable key comprising at least
10 alphanumeric characters (no spaces).

Do not forget the Network Key!

All 1Q5 controllers that are required to be part of the
same Trend network must have the same udp port
number and the same network key. Multiple Trend
networks can exist on the same physical network, in which
case each separate Trend network will require a different
network key.

HINT: For consistency, type the network key into a text
editor (e.g. Notepad), then copy and paste it for each device.

virtual CNCs*

Click Auto Number vCNCs or double-click
on avCNC in the virtual CNCs list and enter
the following:

node - the vVCNC address 1,4 t0 9, 11 to 119
(0 = vCNC disabled)
port - the vCNC port number 1 to 32767

Note: If Use Default Port is checked the port
number will be set to 10000 plus the node
address (e.g. node 23 = port 10023).

The 1Q5 has four vCNCs (or eight when licenced as an NC
device). All VCNCs are all disabled by default. At least one
vCNC must be enabled to allow a supervisor, tool or local
display to make a connection to the Trend system.

For most systems it is recommended to have vCNCs on at
least two separate devices on each LAN in order to provide
continuity of communications (if one device is offline) and
to provide load sharing during intensive data transfer
operations (e.g. when downloading plot data).

LAN*

Enter the required local LAN number:
1,4t09, 11to 119

Note: This must be the same for all devices
required to form a LAN.

0oS*

Enter the required device address:
1,4t09, 11to 119

Note: This must be unique on a LAN.

IQ5 controllers are given a default device address of 119
and LAN number of 20 in the factory.

Identifier

Enter a name that identifies the controller
within the system.

To avoid potential confusion, it is generally recommended
that this is made the same as the hostname.

Click the WRITE DATA button to save the new settings.

Note: If parameters indicated * above are changed the 1Q5 will
reboot when the new values are saved.

STOP!
It is recommended that you complete the above setup for all IQ5 controllers in the Trend network before proceeding.

|
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1Q5, 1Q5-10 Installation Instructions - Configuring

2 CONFIGURATION (continued)

Record the Address Details of the Controller

Device address (O/S)
= LAN number
» Fixed IP Address or Hostname (if DCHP)

Check LAN OK Indicator (not applicable if being used in NC Mode)

m—k j— Normal operation indication
o LAN built OK with at least one other device.
Attempting to build a LAN with other devices
TREND O/ OV. that have the same LAN number and
Network Key. This may take several minutes.
PY Controller set to standalone mode and will
not build a LAN with other devices.

Fault indication

If this continues to show for more than a few
OV. minutes this indicates that the controller has
not found any other devices on the same
LAN. Use IPTool to check device settings.

Connect to the Trend Network using IQSET
Using the Engineering PC/Laptop (see step 7)
run IQSET and make a connection to the Trend <j IQSET Manual (TE200147)

Network (or Site). For example:

= Open a new site (e.g. File > Open/New Project > Live Site). = Click OK twice.

* Inthe IQSET System View panel right-click on Sites and = In the System View panel, double-click the site name in
select New Site. the Sites tree:

= Select Trend as the network type and click OK.

Enter a Site name and click Edit site details. The System View &
Connection Wizard will appear TCP connected to 165.195.95.50, port list = 10101101
) No autedialler in use
»  Select Launching TUA Editor and click Next. The TUA r-
editor will appear. Select the CNC tab: G x G @

Sites

-3 105 Site
Ty TUA - 105 Site x ‘ ! ﬁe[ﬂmdes -
Identification CNC
%s.:':;nneg?uﬁ?:w Qe D O Qe If the 1Q5 (to which you are connecting) already has a System
==l iEE% % Account set up, then you will now be asked to login using the
e 171182 0.1 / TREND 123/ my ia3 com Add appropriate credentials - go to step 20 on page 9.
[] TUA Cnc data is valid LinkPin | 0000
Otherwise, you will be prompted to press the controller’s
service button to validate the connection - go to step 19.

= Select TCP/IP, enter the IP Address (or hostname) of an
IQ5 and add at least one valid vCNC port in the Remote
IP port list.
Note: If using a hostname and DNS or LLMNR is not
supported on the network, add “local’ to the hostname
and ensure that IQSET is connected to the same segment.
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Installation Instructions - Configuring

1Q5, 1Q5-10

2 CONFIGURATION (continued)

(19

If you attempt connection to an IQ5 that has no
system accounts setup, then IQSET will display:

ICE_)I Service Button Validation for New IQ5

Security for this network connection has not been
configured. Before being able to connect and make
changes to this site you must press the service button
on the controller you are trying to connect to.

You have 9:50 mins to press the button.

«  Press the service button & on the controller within the
specified time limit:

/O The LAN OK

indicator will be
Ill flashing fast on the
required controller

O
+ /’%
- J

= IQSET will now display a dialogue box for you to enter an
Account Name, Password and Email address for the
Admin system account.

~

Note: The email address is required in order to recover
from a forgotten password.

= Click to create the account.

=  You will then be given the option to create a single
Engineer system account - click Yes or No as required.

Validate the Connection to IQ5 and Create System Accounts

The new system account(s) will now be set up on the controller
and synchronised with all other 1Q5 controllers on the same
Trend network, i.e. any 1Q5 controller that has:

= the same Network Key and UDP Port set up, and
= no pre-existing system accounts.

This will take a few seconds to complete, after which time
IQSET will display a login box - go to step 20 on page 9.

Note: To add further system accounts go to the System View
in IQSET, right-click the site, select System Account Manager
and follow the instructions in the IQSET Manual.

@ < §> IQSET Manual (TE200147)

Remember to provide the credentials of the Admin
system account plus the Network Key to the site owner
to enable them to manage the system accounts. If the site
owner does not have access to IQSET you may need to add
another Admin system account for each system integrator
working on the site.

@ Login to the Trend Network
If you attempt connection to an 1Q5 that has
system accounts setup, then IQSET will display:

x

ﬁ' Enter credentials for site: Techpubs Rig (IQ5)
Enter user credentials in order to gain access to this
site.

Please Login

= Enter the User Name and Password for a valid Admin or
Engineer system account.

= Click OK.

= In the System View panel click the site name to refresh
the site details (or right-click and select Refresh).

1Q5, 1Q5-10 Controller & 1/0O Modules Installation Instructions - Configuring TG201483 Issue 1, 04-Oct-2023 9



1Q5, 1Q5-10

CONFIGURATION (continued)

Installation Instructions - Configuring

Create Strategy in IQSET

Create an IQSET project and create a strategy
for each 1Q5 controller.

= InIQSET click File > Open / New Project.
= Select Create New SET Project and click OK.
= Enter the required details and click OK.

= Inthe Project View panel add the required LANs by right-
clicking the project name and selecting Insert Lan.

= Enter the required LAN Number and Label, and click OK.

Note: The LAN number should match the LAN(s) defined
using IPTool in step 15.

= Add the required 1Q5 controllers by right-clicking a
LAN and selecting Insert Device > IQ Controller. The
Controller Selection dialogue appears:

Controller Selection ? *
Range Controller
O 101 Device Type: 1Q5-00 ~
(@) (+}] Firmware Version: |4 g v
013 10 Total: 16 ~
IQeco Options
g4 [11Q Interfading [node Contraller
BACnet [ trendLan
O other B-BC Sched.
1q31g410 [J1qview sco
Set 1Q Interfading
Default
Notes
Select 'Cancel' to proceed straight to 'Solution’ selection.
Cancel

= Select 1Q5 and select the required number of 1/0 points
(/0 Total) and licensable features (Options) and click
OK.

<::| IQSET Manual (TE200147)
1Q5 Configuration Manual (TE201486)

= In the Device Details dialogue enter the controller
Address and Name, and click OK.

Note: The Address should match the node(s) defined
using IPTool in step 15.

= In the Address Module dialogue enter any required
settings and click OK.

= In the Sensor Type dialogue enter any required settings
and click Exit.

Set up 10 Modules (if installed)

= Right-click in the empty strategy page and select Device
> 1/O Setup.

* In the 1/0 Setup dialogue add and configure any 10
Modules as required by following the instructions in the
IQSET Manual.

Configure Remaining Strategy (as required)

= Create the remainder of the strategy by following the
instructions in the IQSET Manual and 1Q5 Configuration
Manual.

Local User Modules

It is not necessary to create local User Modules for the 1Q5,
unless these are required to control end users access to the
web interface or the IQVIEW SCD (single controller display).
All engineering access is controlled by the system accounts
created in step 19.

Set up 1Q5 Feature Licencing
If any licensable features are required (e.g.

additional 10 points, NC or INT functionality)
these must now be enabled.

= With IQSET connected (see step 18) and logged in (see
step 20), go to System View.

= Right-click the site name in the Sites tree and select 1Q5
Feature Licensor.

= Select the device(s) required and click to generate a
Licence Request File and save it on the PC.

= Login to the HBT Licensing Portal:
https://MyBuildings.honeywell.com
= Select Quick Cart and upload the License Request File.

= Add any additional details including the email address of
the person requiring the licence, then checkout the order.

<::| See ‘Licence 1Q5 Features’ in the
IQSET Manual (TE200147)

After the order has been processed an email will be sent to
the specified email address. You will then need to...

= Download the Licence File from the Portal and save it.

= Using the 1Q5 Feature Licensor click to import the
Licence File.

= Select which device(s) to update.
=
= Click to update the device licences.

Note: If you are not connected to the same Q5 vCNC that was
used when creating the Licence Request File a warning will
be displayed. If you are connected to the same site you can
ignore the warning. If you are not connected to the same site
connect using a different connection.

10
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Installation Instructions - Configuring 1Q5, 1Q5-10

2 CONFIGURATION (continued)

@ Set up NC Communication Mode (if the IQ5 is required to operate as node controller)

Note: The IQ5 must be licenced for NC mode.

= Using the Engineering PC/Laptop (see step 7) open a Mode

) ! Parameter Settings
compatible web browser and access the IQ5 web interface

mpa Icon
using its IP Address or Hostname. T — | Ethernet Internetwork to to MS/TP LAN (default)
= If prompted, login using valid system account credentials. [=]= Parameter Setting
»  Select Modules > Networks to display the NC wa ﬁ BACNet MSTP [1,41t09, 11to 119
Configuration Wizard. == || LAN number
_ = |[BACnetIP No = Enabled
Gk Disable Module |Yes = Disabled

Manual configuration of all paramters
(not recommended)

Note: In NC mode the IQ5 always has a LAN to connection
to the internetwork and so cannot join another LAN on the
internetwork.

= Click required mode icon (see table), and if necessary
specify any parameters, e.g. LAN number.

Note: If no icons appear, check that the 1Q5 is configured
and licensed for NC operation (see step 21 & 22).

= Click \/; the controller will now reboot.

= Set the communications channel on the MS/TP network
module to the port the MS/TP network is connected to.

Configure or Disable the Web Server (if required)
fie

The 1Q5s web server enables users to access the web
interface for viewing/changing module parameters (including
setting up NC mode - see step 23) or interacting with optional
GraphlQ pages via a web browser.

Q5 Configuration Manual (TE201486)
IQSET Manual (TE200147)

Connection to the IQ5’s web server can be made via HTTP
and/or HTTPS protocol and both these ports are enabled by
default.

Note: Where HTTPS is used it will be necessary to configure
SSL certificates (see the IQ5 Configuration Manual).

If access to the web interface is not required itis recommended
that both ports are disabled for security. For example:

= Using the Engineering PC/Laptop (see step 7) open a
compatible web browser and access the IQ5 web interface
using its IP Address or Hostname.

= If prompted, login using valid system account credentials.
= Select Modules > Networks.
= Select n1 (Ethernet IP).

= Set the Web Server Port Number and/or Secure Web
Server Port Number parameters to 0 to disable the port.

= Click \/

1Q5, 1Q5-10 Controller & 1/0O Modules Installation Instructions - Configuring TG201483 Issue 1, 04-Oct-2023 11



1Q5, 1Q5-10

Installation Instructions - Configuring

2 CONFIGURATION (continued)

Download Strategy to 1Q5 Controller

Use IQSET to download the strategy to the
controller(s).

For a single controller...
= Select the appropriate controller/strategy in the Project
View.

From the Strategy menu select Create Data File.
= Inthe System View select the appropriate controller.
= Right-click the controller and select Send File to Device.

= Inthe File Download dialogue box check that the correct
file is selected the in Transfer Directory field.

=5
= Click 29 to start the download.

For other methods or for downloading to multiple contollers
please refer to the IQSET Manual

@ < §> IQSET Manual (TE200147)

IMPORTANT: The controller’s date and time MUST be set
correctly to ensure that the controller’s security certificates
can be correctly validated. Communications issues will occur
if the security certificates are not valid. This can be done by
selecting the option to set the controller’s time is selected
when downloading the strategy.

Note: If the strategy uses an NTP server to set the IQ5’s time
and date, synchronisation will only occur if the IQ5’s time and
the server’s time are within 49 days of each other.

Note: The controller’s date and time may be set up from a
controller configured as timemaster.

j_'

@/_ T2 3
O o O O

=y

@ Check RS-485 Network Indicators (if RS-485 devices are connected)
M

Normal operation indication

© | Port configured OK and communications are good.

PY Port not active. No Network module exists in the
controller strategy or is not configured correctly.

Fault indication

@ |No communications or no network connected.

port 1 until BACnet devices are connected.

Note: A controller configured for NC operation will show @ on

LR

Check Status Indicator of T1L 10 Bus Modules (if connected)

Normal operation indication

@ Module operational and address set OK.

Module is booting up - please wait a few
minutes and check again.

If all modules are in this state, go to step

29 on page 14.
Fault indication

R Module not addressed correctly - go to
) D step 28 on page 13.
S

HOA module not addressed correctly - go
to step 28 on page 13.

Note: Rotary control has been operated.

A

18
Module not powered - check connection
from previous module or separate PSU (if

applicable)
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Installation Instructions - Configuring 1Q5, 1Q5-10

2 CONFIGURATION (continued)

@ Setting the Address of a Module
The 1Q5 controller will automatically attempt to match each physical I/O module with its corresponding strategy 1/0

module and set its address accordingly.

However, the controller will be unable to set the address of a
module if:

= there is more than one unaddressed physical module of
the same type,

= there is more than one unaddressed strategy module of
the same type, or

= there is no corresponding I/0 module in the strategy.

Should any of the above situations arise it will be necessary
to set the address of any affected module using either of the
following methods.

Method 1: Use the 1Q Tool Soft Addresser Applet in IQ®SET. Note: If a module is not visible in either the applet or the
web interface, it may be because it has already be used

with —another controller. A module becomes bound to the
@ <‘;| b I$E20001I3%%ﬂ Addresser Applet Manual first controller it connects to over the T1L bus. If connecting

the module to a different controller it will need to be reset as
= Use the applet to assign the physical I/O module to the  shown in section 7 on page 20.
appropriate strategy 1/0 module.

Method 2: Use the controller web interface.

@ < §> 1Q5 User Guide (TE201490)

= Login to the controller’s web interface.
= Access the /O Module page and enter module addresses
as required.

Identifying a Module using the ‘Wink’ Function (if required)

To help indentify a specific module it can be placed in ‘wink’ mode, either from the module itself or set up tool. While in wink
mode the module’s service indicator #lA will flash and the status indicator ring of the corresponding controller will also flash
green.

Method 1: Use the module’s service button.. Method 2: Use the IQ Tool Soft Addresser Applet in IQ®SET.

= Press the module’s service button # briefly (<3 seconds).
- The module’s service indicator #I& will flash for < b 1Q Tool Soft Addresser Applet Manual

approximately 2 minutes, showing that the device is in (TE201356)
wink mode. .
= Open either the 1Q Tool Soft Addresser Applet or the = Click the button for the appropriate module.
controller’s web interface (see Method 2 and 3). = The button background will flash green and the module’s
= Any module in wink mode will have its Wink parameter service indicator #IA will flash, showing that the device
setto ‘On’. is in wink mode.

= Click the button again to turn off wink mode.

Method 3: Use the controller web interface.

@ < §> IQ5 User Guide (TE201490)

= Login to the controller’s web interface.
Access the 1/0 Module page.

= In the Wink column set the parameter to ‘On’ for the
appropriate module.

»  The module’s service indicator #IA will flash, showing
that the device is in wink mode. It will continue to flash
until the corresponding Wink parameter is set back to
‘Off".

|
1Q5, 1Q5-10 Controller & 1/0O Modules Installation Instructions - Configuring TG201483 Issue 1, 04-Oct-2023 13



1Q5, 1Q5-10 Installation Instructions - Configuring

2 CONFIGURATION (continued)

Switch Off Controller (including additional /0 Bus PSUs)

PSU PSU
. | -
|~| 105 [ 1a5-10 | 1a5-10 | 105-10 | 1a5-10 [ 1510 [ 1a5-10
— = 5
S
/ﬁ PSU (e
‘ -

Reconnect Inputs
el T TalTTTal e siillalllle

—__J -
| ~| 105 | 1050 | 1as-10 | 10510 | 105-10 | 1a5-10 | 10510
— H =

14

CAUTION: Check that each input connection is appropriate for the IO module input type. For example, ensure that a
mains voltage is not applied to a low voltage input.

@ Switch On Controller & Input Supplies (including additional /O Bus PSUs)

PSU \5 ’ PSU N PSU PSU
- | I = ul}
IINIIINIININ
~| 105 [ 1a5-10 | 10510 | 105-10 [ 1a5-10 | 1a5-0 [ 10510
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Installation Instructions - Configuring 1Q5, 1Q5-10

2 CONFIGURATION (continued)
@ Check Input Operation
1Q5-10 Modules

Analogue % Digital

Channel Indicator

QO —oo

Q® -

1Q4/10 Modules

@ <:| b 1Q4/10/.. Installation Instructions - Configuring (TG201161)

Section 4 Only

XCITE/IO Modules

@ <j b XCITE/IOL.. Installation Instructions - Configuring (TG200627)

Section 4 Only

Switch Off Controller & Input Supplies (including additional 1/0 Bus PSUs)

PSU A

PSU

PSU PSU

||||||||||||||| WFH[H

“""| 1Q5 | 1Q5-10 | 1Q5-10 || 1Q5-10 || 1Q5-10

[ 1as-10 | 105-10

@ Reconnect Outputs

M J

= =
| 1a5-0 | 10510

[~ 105 [ 1a5-10 [ 1a5-10 [ 10510 ] 1as-10
L

LR

T

CAUTION: Check that each output connection is appropriate for the IO module output type. For example, ensure that
a mains voltage is not applied to a low voltage output.
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1Q5, 1Q5-10 Installation Instructions - Configuring

2 CONFIGURATION (continued)

Switch On Controller, Input & Output Supplies (including additional /0 Bus PSUs)

g PSU | ] PSU g PSU PSU
| I il
IINIIRIINITe L
[~| 105 [ 1a5-0 [ 1as-10 | 1as-10 | 1a5-10 1a5-10 | 1a5-10
MMM §
] .
@ Check Output Operation
1Q5-10 Modules
Analogue Digital

Channel Indicator Channel Indicator

1Q4/10 Modules

@ <:: b 1Q4/10].. Installation Instructions - Configuring (TG201161)

Section 4 Only

XCITE/IO Modules

@ <:j b XCITE/IO/.. Installation Instructions - Configuring (TG200627)

Section 4 Only

Backup Strategy
@ - b IQSET Manual (TE200147)

Once the system is working as expected, it is good practice to
upload the strategy from each controller into IQSET to create
a backup.

If required, you can also compare this uploaded strategy with
that held in your project and check for any differences.
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Installation Instructions - Configuring 1Q5, 1Q5-10

2 CONFIGURATION (continued)

@ Install Supervisors or Displays (if required)
If a supervisor or local display is required, install these now following the appropriate

@ <,‘ZI b installation instructions and the guidance notes below. Otherwise go to step 32 on page 18.

Connection Method Suitable for
IP Tool IQSET Supervisor Web Interface
(e.g. IQVISION) (e.g. IQVIEW SCD for 1Q5)
Direct via Ethernet Port 4 v v v
Via Ethernet Network v v v v
Direct via USB Engineering Port x v x x
* connection requires a vVCNC to be configured on the target controller.
Direct Connection via Ethernet Port Connection via Ethernet Network
m 5 A a
_k J_ IQVIEW _\ J_ IQVIEW
SCD SCD

Standard Ethernet cable
(Cat 5e twisted pair)
max 100 m (109 yds)

Standard Ethernet cable
(Cat 5e twisted pair)
max 100 m (109 yds)

= To make a connection with IQSET or supervisor ensure

that a vCNC is available in a Trend device on the same
Ethernet Trend network and connect to the VCNC as o Router IEI IEI IE IE
described in the supplied documentation. Hub / Switch

Note: If connecting with IP Tool, the PC should be on the
same Ethernet segment as the 1Q5.

= To make a connection with a web browser run the web
browser on the PC and access the 1Q5’'s IP address or
host name.

= To make a connection with an IQVIEW SCD, install the
IQVIEW SCD application on the controller, then configure
the display device with the URL of the IQ5 controller. For
full details see IQVIEW Single Controller Display for 1Q5
Manual (TE201504).

Direct Connection via USB Engineering Port

L J=

|\, O
T ——

connector
(behind flap) USB cable

This method is only suitable for a temporary connection with
IQSET during system commissioning or fault finding.
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2 CONFIGURATION (continued)

@ Close Panel / Enclosure
The configuration procedure is now complete!

|
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Installation Instructions - Configuring 1Q5, 1Q5-10

3 RESETIQ5 CONTROLLER TO FACTORY DEFAULTS

A factory reset will erase the strategy and reboot the controller into its default configuration.

@ Isolate Power and Disconnect All I/O
Follow steps 1, 2, 4, 8 and 9 (on pages 1 to 4) to:
= Isolate Power,
= Open Panel,
= Disconnect All I/O,
= Unplug all Ethernet cables. Any RS-485 networks may be left connected,

= Switch on power to Q5 only,
= Wait for controller to settle.

@ Perform the Reset

Press and hold down the service button # (located behind  The reset process may take up to several minutes
the drop down flap) until the ring indicator flashes yellow, then depending on the controller type. Do not remove power
release the button. To initiate the reset press the button again  to the controller until the process has completed.

while the indicator is still flashing.

While the controller is erasing the strategy, the ring indicator
will remain yellow and appear to ‘rotate’. When the reset is
complete the controller will reboot as shown in step 9 on page
4.

The strategy, user modules (passwords, etc), alarm logs, and
plots records are cleared down, and all other parameters will
be returned to their default settings as shown in step 15 on
page 7.

Note: Time and date are left at their current values, and the
license is not affected by the reset.

4 ™
=10's 5s 60s 10s
Controller
i ))TA will then
: 2 reboot,
: see step 9.
Long Press Release Short Press
>0 50O
7 7 7 G
+ » % ORI
\ J

@ Re-configure the Controller
Go to step 15 on page 7.
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1Q5, 1Q5-10 Installation Instructions - Configuring

4 RESET IQ5-10 MODULE TO FACTORY DEFAULTS

A factory reset will erase all input/output settings and module address and reboot the module into its default configuration.

Isolate Power and Disconnect All I/O from the Module
Follow steps 1, 2, 4, 8 and 9 (on pages 1 to 4) to:

= Isolate any power supplies used by the module inputs or outputs,
= Open panel,

= Disconnect all I/O from the module,

= Isolate the module power supply.

Perform the Reset

With the module powered up, use the service button to initiate Thereset process will only take a few seconds depending
the reset process as follows: on the module type. Do not remove power to the module
until the process has completed.

B —— When the reset is complete the module will reboot and the
controller will attempt to re-address the module as shown in
step 1 on page 14.

4 ™
=10's i <5s | <5s
° e Q) o) ‘@ |
Fla 5 o i 5 ; Module wil
i ; then reboot into
i i default state
Long Press Release EShort Press
O 10-15s ' O <5s O
r A 7
A # A
\ J

Reconnect Inputs & Outputs and Check Operation

Follow the guidance from step 27 on page 12, through to step 31 on page 17.

Please send any comments about this or any other Trend technical UK
publication to techpubs@trendcontrols.com C n
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